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1Installation Overview

In this section:

• Overview of Installation Process . . . . . . . . . . . . . . . . . . . .10



Overview of Installation Process
The following diagram illustrates the process of installing Pitney Bowes Spectrum™ Technology Platform
for the first time:

To start the installation process you insert the Spectrum™ Technology Platform DVD and run the installer.
(If you downloaded Spectrum™ Technology Platform from the Pitney Bowes Software web site, you start
the installation process by running the installer from the location where it was downloaded.)

Spectrum™ Technology Platform can be installed from media or by downloading the software
from the Pitney Bowes Software Technical Support web site. Once you have downloaded the

Note:

files, the installation process is the same regardless of whether you are using physical media or
downloaded software for the installation.

After you have installed Spectrum™ Technology Platform you will then install the databases that support
the module(s) you have installed. For example, if you have installed the Enterprise Geocoding Module,
you will need to install databases that contain geospatial data; if you have installed the Universal Ad-
dressing Module, you will need to install databases that contain postal data. Most databases are included
in your shipment, but some U.S. postal data must be downloaded from the USPS® website.

Once Spectrum™ Technology Platform, modules, and databases are installed, you install the client tools
by downloading them from your Spectrum™ Technology Platform server. The client tools are:

• Management Console—Used for administering Spectrum™ Technology Platform.
• Enterprise Designer—Used for creating and modifying dataflows and process flows.
• Interactive Driver—Used to preview output from services.
• Job Executor—A command line tool that allows you to run jobs from a command line or script.
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• Process Flow Executor—A command line tool that allows you to run process flows from a command
line or script.

If you will be integrating Spectrum™ Technology Platform into an application, you will need to install the
Client API on the computer where you will be developing the application. The Client API allows access
to Spectrum™ Technology Platform through several programming languages, including Java, C++, and
web services. You can install the Client API directly to your computer or on the Spectrum™ Technology
Platform server, where it can be downloaded as needed.

Finally, with Spectrum™ Technology Platform installed successfully, you will need to obtain a license
file from Pitney Bowes Software which provides long-term access to your software.
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2System Requirements

In this section:

• Server Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14
• Client Tools Requirements . . . . . . . . . . . . . . . . . . . . . . . . .16



Server Requirements

Operating Systems

• AIX 6.1 1

• AIX 7.1 1, 2

• HP-UX 11.31 (Itanium) 1, 3

• Solaris 9 (SPARC only) 1

• Solaris 10 (SPARC only) 1

• Red Hat 5 4

• Red Hat 6.1 with the following required packages: 4

• Linux Standard Base
• glibc.i686 glibc-devel.i686
• zlib.i686 zlib.x86_64 zlib-devel.i686 zlib-devel.x86_64
• libstdc++.i686 libstdc++-devel.i686 libstdc++-devel.x86_64
• compat-libstdc++-33.i686 compat-libstdc++-33.x86_64

• SUSE 10.0 4 (requires glibc-2.4-31.2 which is approximated by the standard SUSE 10.1 distribution)
• SUSE 11.1 4 (requires glibc-2.9 or glibc-2.11)

Disk Space

• 2 GB to install all modules, less if installing fewer modules
• You will also be loading one or more databases. The total disk space varies, depending on what
modules(s) and what database(s) you are installing.

• Typically you should have 2 GB to 3 GB of temp space for the installation to extract the files it needs,
but you may need more depending on the options you are installing. If necessary, modify your
IATEMPDIR environment variable to point to a location with enough space.

Memory

• Basic memory requirement: 2 GB
• The Enterprise Geocoding Module requires an additional 500 MB memory for the first non-U.S. geo-
coder, and 250 MB for each additional non-U.S. geocoder, with these exceptions:

• Germany, Australia, and the U.K. each require 1 GB additional memory

1 The Universal Address Module component Validate Address AUS is not supported on this operating
system.

2 To use the Address Now Module on this operating system you must install the gcc332 libraries.
3 The Address NowModule, GeoConfidence Module, Location Intelligence Module, and Universal Address
Module component Validate Address Global are not supported on this operating system.

4 The Universal Addressing Module component Validate Address AUS is not supported on this operating
system.
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• Japan requires 2 GB additional memory

Note that you may distribute processing amongmultiple servers which may allow you to take advantage
of existing hardware instead of adding memory to a single Spectrum™ Technology Platform server.
This is referred to as remote server processing. For information on remote servers, see the Spectrum™

Technology Platform User's Guide.
• The Data Normalization Module and Universal Name Module require additional memory if you use
the following name databases:

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

The Arabic Plus Pack and Asian Plus Pack databases are only supported on 64-bit computers.Note:

Network Ports

• 1701—Used to maintain a connection to an internal database.
• 8080—Used for HTTP communication with all clients including COM, .NET, C, etc. During the install-
ation process you are given the option to specify a different port for HTTP communication.

• 10119—Used for proprietary SOCKET client communication protocol.

You can modify these ports by editing the following file: $G1DCG/serv-
er/app/conf/spring/spectrum-container.properties. You will need to restart the
server if you change this file.

Note:

Network port conflicts can result in module components failing to start up. One indication that a component
has failed to start up is if it does not appear in the Management Console. To troubleshoot the problem,
look in the Spectrum™ Technology Platform log file. This log shows which port is causing the problem.
You can find the Spectrum™ Technology Platform log file in:

$G1DCG/server/app/repository/logs/server.log

where %G1DCG% and $G1DCG are the environment variables for the Spectrum™ Technology Platform
directory.

Additional Requirements

• For all Unix/Linux systems, a minimum of 8192 file descriptors is required. This can be set by running
the ulimit command:

ulimit –n 8192

• For IBM AIX systems only, you must download and install Java 6 before installing Spectrum™ Tech-
nology Platform. If you do not have Java 6 installed, download and install it from:

www.ibm.com/developerworks/java/jdk/aix/service.html

• DVD-ROM drive with driver support for mounting ISO 9660 filesystems
• Root privileges
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Requirements for the Address Now Module

• Redhat/SuSe Linux—512 MB RAM, gcc compiler, and library version 4.1.2
• Sun Solaris—At least an UltraSparc processor with a speed of at least 400 MHz and at least 512 MB
RAM, gcc compiler, and library version 3.3

• AIX—Version 5.3 with gcc compiler and library version 3.3
• HP-UX—Version 11.23 or greater with gcc compiler and library version 4.1

Client Tools Requirements
• Operating system requirements:

• Windows XP
• Windows 7

• The following is the amount of disk space needed to install the client without any modules. Each
module you install requires additional disk space.

• Enterprise Designer, Management Console, and Interactive Driver—86 MB
• Client API—1.25 GB

• Microsoft .NET Framework 4.0 (available from the Spectrum™ Technology Platform Welcome Page,
http://<SpectrumServerName>:8080)

• A monitor with 800 x 600 resolution
• Maximum DPI settings:

• Windows XP: Large size (120 DPI)
• Windows 7: Medium - 125%

• JDK 1.6 is required to install the Client API. Be sure that JDK 1.6 is in the PATH environment variable.
Once installed, the Client API supports JDK 1.4 and greater.

• iSeries platforms support the Client API in Java only
• Adobe Reader 7 or later (for viewing and saving reports)
• To use the Business Steward Portal or the Data Hub Relationship Analysis Client, a browser with Mi-
crosoft Silverlight 4 installed. See www.microsoft.com/getsilverlight.
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3Installing the Server and
Modules

In this section:

• Upgrading from a Previous Version . . . . . . . . . . . . . . . . .18
• Installing Spectrum™ Technology Platform . . . . . . . . . . .18
• Using the Silent Installer . . . . . . . . . . . . . . . . . . . . . . . . . .20
• Adding a Language Pack . . . . . . . . . . . . . . . . . . . . . . . . . .20



Upgrading from a Previous Version
Before upgrading, be sure to read the release notes for the new version. The release notes contain im-
portant compatibility information as well as release-specific installation notes.

1. Source the <SpectrumLocation>/server/bin/setup script.
2. Execute the<SpectrumLocation>/server/bin/server.stop script to shut down theSpectrum™

Technology Platform server.
3. If you have the Address Now Module installed, shut down the Address Now server by executing the

<SpectrumLocation>/server/bin/stop_adn_server.sh script.
4. If you have the Global Sentry Module installed, shut down the Global Sentry server by executing the

<SpectrumLocation>/server/GlobalSentryDatabase/bin/globalsentrydb.stop script.
5. The files in the folder <SpectrumPlatformLocation>\serverwill be deleted. Before upgrading,

review the files and folders in this location and back up any files you have modified. If you are installing
the Siebel or SAPmodules, be sure to back up existing dataflows, especially any that are customized.

6. If you want to change the location where Spectrum™ Technology Platform is installed, uninstall the
existing Spectrum™ Technology Platform installation first. For instructions on uninstalling, see Re-
moving Spectrum on page 91.

7. Run the Spectrum™ Technology Platform installer to upgrade your system.

Installing Spectrum™ Technology Platform
Before installing Spectrum™ Technology Platform, be sure to read the release notes. The release notes
contains important compatibility information as well as release-specific installation notes.

You must have root privileges to install Spectrum™ Technology Platform.Note:

1. Open the Spectrum™ Technology Platform installation package.

• If you are installing from DVD:

• Insert the Spectrum™ Technology Platform DVD.
• If it does not auto-mount, issue the appropriate mount command to indicate that the DVD device
is a file system. For more information, see your system's man pages for the mount(1) command
and allow for lower case.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a
file system. You may experience file loading difficulties when using DVDs mounted with

Note:

the Rockridge extension. Pitney Bowes Software recommends using the standard ISO
9660 format without extensions.

• If you are downloading Spectrum technology Platform:
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• Go to www.g1.com/support, log in, and browse to My Products > Spectrum™ Technology
Platform. Download the software and obtain the access key for each module you are installing
as well as the databases for your modules.

• Extract the zip file. Make sure that the Use Folder Names check box is selected before extracting
the files, otherwise your folder structure will not be correct.

• Transfer the extracted file to the server where you want to install Spectrum™ Technology Platform.

2. Change the directory to the location of install.sh (either the DVD or the location where you
downloaded Spectrum™ Technology Platform from the Pitney Bowes Software web site). For example:

cd /cdrom/

The item /cdrom is the name of the mounting point for the system's DVD as a file system.
Change this as necessary for your system. Use the correct device name for the DVD device

Note:

on your system. You must have read permission on the DVD device. On some systems, this
may be limited to root users. Also, on some systems, the file names on the DVD may be
changed to all uppercase letters. List the directory on your DVD directory (ls/cdrom) to see
the names of the files.

3. Be sure you have execute permission on the files by typing the following command:
chmod a+x install.sh

4. Execute install.sh from the media or from the location where you placed the downloaded files.
5. The install script walks you through the installation process.

• When prompted, select the modules that you want to install.

• If you are upgrading from a previous version of Spectrum™ Technology Platform, your currently
installed modules are selected.

• If this is the first time you are installing Spectrum™ Technology Platform, make sure that Spec-
trum™ Technology Platform is selected.

• If you are installing the SAP Module you must install these modules: Address Now Module and
Advanced Matching Module. The Enterprise TaxModule is optional. TheUniversal Addressing
Module is only required if you will be using the SAP module service SAPValidateAddressWith-
Candidates.

• If you are installing the Siebel Module you must install these modules: Advanced Matching
Module, Data Normalization Module, and Universal Name Module You may need to install one
or more of these modules depending on the features you have licensed: Address Now Module,
Enterprise Geocoding Module, and Universal Addressing Module.

• If you are on a 64-bit platform, you are prompted to select 32-bit or 64-bit architecture. Note that
after you make this selection, you will be able to change it just once upon upgrading to a new
version. After that, you will need to uninstall and reinstall Spectrum™ Technology Platform to make
a subsequent change.

• If no previous version is detected, you are prompted for the HTTP port number. Enter the HTTP
port that you want to use and then press Enter. The default is 8080. For a complete listing of ports
used by Spectrum™ Technology Platform see System Requirements on page 13.

• When prompted, enter your access keys, one key per line. The number of access keys you have
depends on which features you licensed. Your access keys can be found on the packing slip included
with your shipment and the shipment notification email. Access keys are case sensitive. If you do
not have access keys, you can obtain them from www.g1.com/support, under My Products. Note
that some databases require access keys, which you should enter now.

Access keys expire 21 days after receipt.Note:
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6. If you installed the Global Sentry Module, the server starts automatically. To start or stop the server
manually:
a) Change directories to <Spectrum Platform>/GlobalSentryDatabase/bin.
b) Source the setup file by typing . ./setup.
c) Type ./globalsentrydb.start to start the server.
d) Type ./globalsentrydb.stop to stop the server.

Using the Silent Installer
The silent install process allows you to pre-configure the installation process so that it runs without user
intervention. Instead of the user responding to prompts from the installation process for information such
as the installation location and which modules to install, you specify these responses in a properties file
which the installer uses instead of user prompts.

1. On the Spectrum™ Technology Platform DVD, browse to the SilentInstaller folder. If you
downloaded Spectrum™ Technology Platform from the technical support website, this folder is in the
media image you downloaded.

2. Open the file installer.properties in a text editor.
3. Edit installer.properties as necessary to specify the installation settings you want to use.

See the comments in installer.properties for additional information.
4. To run the installer in silent mode, place installer.properties in the same directory as install.sh.

When the installer executes it will detect installer.properties and automatically run in silent
mode.

Alternatively, you can place installer.properties in different directory and give the absolute
path to the property in the command prompt using the -f argument, as follows:

install.sh -f %PathOfPropertyFile%\installer.properties

Adding a Language Pack
A language pack provides translated UI and documentation for a particular language. To install a language
pack, follow this procedure.

1. Stop the Spectrum™ Technology Platform server.
2. Download the language pack from www.g1.com/support.
3. Extract the downloaded zip file to a temporary location on the Spectrum™ Technology Platform

server.
4. Do one of the following:

• For Windows, open the i18n folder and run i18ninstall.exe.
• For Linux and Unix, open the i18n folder and be sure you have execute permission on the files

by typing the following command: chmod a+x i18ninstall.sh. Then, execute i18nin-
stall.sh.
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5. Follow the prompts.
6. After the installation completes, start the Spectrum™ Technology Platform server.
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4Installing Databases

In this section:

• Introduction to Databases . . . . . . . . . . . . . . . . . . . . . . . . .24
• Installing the Address Now Module Database . . . . . . . . .24
• Installing the Advanced Matching Module Database . . .25
• Installing Data Normalization Module Databases . . . . . .26
• Installing Enterprise Geocoding Module Databases . . . .27
• Installing Enterprise Routing Module Databases . . . . . .31
• Installing Enterprise Tax Module Databases . . . . . . . . . .32
• Installing the Global Sentry Module Database . . . . . . . . .36
• Installing Location Intelligence Module Databases . . . . .38
• Installing Universal Addressing Module Databases . . . .38
• Installing Universal Name Module Databases . . . . . . . . .41



Introduction to Databases
Databases provide the information that Spectrum™ Technology Platform modules use to process data,
such as postal address data, name data, or geospatial data. These databases vary in size from a few
hundred megabytes to over a gigabyte.

• Installing the Address Now Module Database on page 24
• Installing the Advanced Matching Module Database on page 25
• Installing Data Normalization Module Databases on page 26
• Installing Enterprise Geocoding Module Databases on page 27
• Installing Enterprise Routing Module Databases on page 31
• Installing Enterprise Tax Module Databases on page 32
• Installing the Global Sentry Module Database on page 36
• #unique_25
• Installing Universal Addressing Module Databases on page 38
• Installing Universal Name Module Databases on page 41

Installing the Address Now Module Database
If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. Copy the liclcs.sbi license file provided by Pitney Bowes Software into the following directory:
<SpectrumPlatformLocation>/server/modules/anow/license.

2. Make sure that Spectrum™ Technology Platform is stopped. To stop Spectrum™ Technology Platform,
change the working directory to the bin directory of where Spectrum™ Technology Platform is installed,
then type the following command:
./server.stop

3. Insert the database DVD containing the database(s) you want to install.

You must install the Postal databases if you want to use the Enhanced databases.Note:

4. If your system does not auto-mount the DVD, issue the appropriate mount command to indicate that
the DVD device is a file system.

If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. Run the load_adn_db script inside <SpectrumPlatformLocation>/server/bin.
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6. Press <Enter> to accept the default location of the Address Now directory: <SpectrumPlatform-
Location>/server/modules/anow. Do not change this path or the database will not install cor-
rectly.

7. Follow the prompts as the script verifies your environment and database location. When prompted
for the location of the Installation Media Directory, be sure to select the directory on the database
DVD that contains the kbase folder.

8. Start the Address Now server by going to <SpectrumPlatformLocation>/server/bin and
running the start_adn_server script.

9. Start the Spectrum™ Technology Platform by changing the working directory to the bin directory of
where Spectrum™ Technology Platform is installed, then type the following command:
./server.start

Installing the Advanced Matching Module Database
The Advanced Matching Module provides a load utility to install databases. The database files that you
install depend on the databases you have licensed.

1. If you have Oracle environment variables set in your profile, these environment variables may interfere
with DVD database loading processes. If you experience database loading problems and are using
Oracle, check that the Oracle environment variables are not active when you perform the DVD
database loads.

2. Make sure that Spectrum™ Technology Platform is stopped. To stop Spectrum™ Technology Platform,
change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled, then type the following command:
./server.stop

3. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

4. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system.

If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. Change the working directory to the bin directory of where Spectrum™ Technology Platform is installed.
6. Source the "setup" bourne shell script to setup the environment by typing the following command:

. ./setup

7. Execute the script for installing the database by typing the following command:
./installdb_cdq

8. Follow the prompts as the script verifies your environment and database location.
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9. If the database requires keys and you have not entered the key, see Adding Modules and Features
on page 87 for instructions on adding access keys.

10. Open the file <SpectrumDirectory>/server/bin/wrapper/wrapper.conf in a text editor.
11. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum heap

size (wrapper.java.maxmemory) to reflect the total amount of memory required for the Arabic
Plus Pack and Asian Plus Pack. For the amount of memory required by these databases, seeMemory
on page 14.

12. Save and close wrapper.conf.
13. Start the Spectrum™ Technology Platform by changing the working directory to the bin directory of

where Spectrum™ Technology Platform is installed, then type the following command:
./server.start

Installing Data Normalization Module Databases
The Data Normalization Module provides a load utility to install databases for the Advanced Transformer,
Open Parser, and Table Lookup components. The database files that you install depend on the databases
you have licensed. Use this list of database tables to determine which files you should download and
install. For more information on the tables contained in each database, refer to the reference document-
ation for each component.

Advanced Transformer

• Data Normalization Module - Base Tables

Open Parser

• Data Normalization Module - Base Tables
• Core Names Database
• Company Names Database
• Arabic Plus Pack
• Asian Plus Pack

Table Lookup

• Data Normalization Module - Base Tables
• Core Names Database
• Arabic Plus Pack
• Asian Plus Pack
• ZREPLACE (Used by the SAP Module for French address validation)

1. If you have Oracle environment variables set in your profile, these environment variables may interfere
with DVD database loading processes. If you experience database loading problems and are using
Oracle, check that the Oracle environment variables are not active when you perform the DVD
database loads.

2. Make sure that Spectrum™ Technology Platform is stopped. To stop Spectrum™ Technology Platform,
change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled, then type the following command:
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./server.stop

3. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

4. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system.

If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. Change the working directory to the bin directory of where Spectrum™ Technology Platform is installed.
6. Source the "setup" bourne shell script to setup the environment by typing the following command:

. ./setup

7. Execute the script for installing the database by typing the following command:
./installdb_dnm

8. Follow the prompts as the script verifies your environment and database location.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

9. If the database requires keys and you have not entered the key, see Adding Modules and Features
on page 87 for instructions on adding access keys.

10. Open the file <SpectrumDirectory>/server/bin/wrapper/wrapper.conf in a text editor.
11. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum heap

size (wrapper.java.maxmemory) to reflect the total amount of memory required for the Arabic
Plus Pack and Asian Plus Pack. For the amount of memory required by these databases, seeMemory
on page 14.

12. Save and close wrapper.conf.
13. Start the Spectrum™ Technology Platform by changing the working directory to the bin directory of

where Spectrum™ Technology Platform is installed, then type the following command:
./server.start

Installing Enterprise Geocoding Module Databases
This module has several databases. You may have one or more of these, depending on the features
you have licensed.

• International Geocoding Databases on page 28
• U.S. Geocoding Databases on page 29
• U.S. Reverse Geocoding Databases on page 30
• Points Databases (U.S. Only) on page 30
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• Early Warning System (U.S. Only) on page 31

International Geocoding Databases
International geocoding databases contain the data necessary to perform geocoding and reverse geo-
coding for locations outside the U.S. Each country has its own database, and some countries have op-
tional databases that provide enhanced geocoding.

If you install multiple databases, install each database to a separate folder.Note:

To install the international geocoding databases you need to meet the following requirements:

• You must have Java 6 installed.
• You must point your Java_Home environment variable to your JDK 1.6 installation location.

If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

2. If your system does not auto-mount, issue the appropriate mount command to indicate that the DVD
device is a file system. If necessary, issue the /etc/filesystem command to update your system
so that it recognizes this file system. Specify the correct device name for the DVD device on your
system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

3. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

4. Source the "setup" bourne shell script to setup the environment by typing the following command:
. ./setup

5. Execute the dbloader.bin script.
6. Follow the prompts as the script verifies your environment and database location.

Do not install geocoding databases on a network drive. Doing so can cause performance
problems.

Note:

7. If the database requires keys and you did not enter the key for the database, see Adding Modules
and Features on page 87 for instructions on adding access keys.

8. After you install the database files, use the Database Resource tool in the Management Console to
define the database as a resource. For more information, see "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform User's Guide.

If you installed the Australia Geocoded National Address File (G-NAF), you must specify the
GNAF123 andGNAF456 subfolders as separate database resources in theManagement Console.

Note:
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If you install the Australia Geocoded National Address File (G-NAF), there will be two subfolders: GNAF123
and GNAF456. GNAF123 contains the point-level dictionary. This has the highest precision of geocoding
(characterized by Reliability Level 1, 2, or 3.) GNAF456 contains the remainder of address information
in G-NAF that does not meet high precision geocoding criteria (characterized by Reliability Level 4, 5,
or 6.) We recommend that you use both databases to validate the existence of addresses but only use
GNAF123 for parcel-level geocoding. If you do not require parcel-level geocodes you can use GNAF456
for geocoding.

U.S. Geocoding Databases
The U.S. geocoding databases contain the spatial data necessary to perform address standardization
and geocoding. You must install at least one of these databases.

• Centrus Enhanced Geocoding—This database consists of TIGER data provided by the U.S. Geolo-
gical Survey and address data provided by the U.S. Postal Service.

• GDT Geocoding—This database providesmore up-to-date data than the Centrus EnhancedGeocoding
database. It requires an additional license. GDT data is provided by Tele Atlas, a third-party provider
of spatial data, and postal data from the U.S. Postal Service.

• NAVTEQ Geocoding—This database provides more up-to-date data than the Centrus Enhanced
Geocoding database. It requires an additional license. NAVTEQ data is provided by NAVTEQ, a third-
party provider of spatial data. For more information about these databases, contact your sales repres-
entative.

• ZIP + 4 Centroid—This database provides only address standardization and ZIP + 4 centroid matching.
It does not provide street-level matching.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the files us.Z9
contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide Intersection
Index is designed to enable fast intersection identification on a statewide basis. For example, the Statewide
Intersection Index will allow the database search for "1st and Main St, CO" and return a list of possible
matches in Colorado more quickly than searching the entire geocoding database for each instance of
the intersection.

If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

2. If you are installing from DVD and your system auto-mounts, skip this step. If you system does not
auto-mount, issue the appropriate mount command to indicate that the DVD device is a file system.
If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:
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3. If you have previously installed the Centrus Data Product Suite, delete any copies of the .gsd, .gsl,
.gsi, .gsu, .gsz, .z9, .dir, .las, .los, .apn and .elv files.

4. Copy the files you need to a local directory.
5. If you installed the Zip5.gs_ file, decrypt the file using the Centrus_decrypt program located on

your installation media in the /datasets/unix/ <platform> directory. Enter the password when
prompted.

You can find your password in the email containing your license file.Note:

6. After you install the database files, use the Database Resource tool in the Management Console to
define the database as a resource. For more information, see "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform User's Guide.

U.S. Reverse Geocoding Databases
If you are licensed for Reverse Geocode US Location, you need additional data files called gsx files.
The data installation wizard prompts you to create these files. If you choose not to create these files you
must run the batchind utility after installing the geocoding database. This utility creates the reverse
geocoding files. This utility can be found in server/modules/geostan/bin. Before running batchind,
create a subdirectory called gsx in the location where you installed the geocoding database. When you
run batchind, specify the gsx folder as the location for the gsx files.

Points Databases (U.S. Only)
Points databases contain data for locating the center of a parcel. These databases provides enhanced
geocoding accuracy for internet mapping, property and casualty insurance, telecommunications, utilities,
and others.

• Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

• Centrus Elevation—This database contains the same data as Centrus Points, plus elevation data.
• Centrus Enhanced Points—This database contains the same data as Centrus Points, plus APN
data.

• Centrus Premium Points—This database contains the same data as Centrus Points, plus both APN
and elevation data.

• Centrus Tele Atlas Points Database—The data in this database is provided by Tele Atlas, a third-
party provider of spatial data.

If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:
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2. If you are installing from DVD and your system auto-mounts, skip this step. If you system does not
auto-mount, issue the appropriate mount command to indicate that the DVD device is a file system.
If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

3. If you are installing a Centrus points database:
a) If you have previously installed any of the Centrus points databases, delete these files:

cpoints.gsd, cpoints.gsi, cpoints.apn, cpoints2.apn, cpoints3.apn, and
cpoints.elv.

b) Copy these files to the Spectrum™ Technology Platform server: points.gsd, cpoints.gsi,
cpoints.apn, cpoints2.apn, cpoints3.apn, and cpoints.elv.

4. If you are installing the Centrus TomTom Points database:
a) If you have previously installed the Centrus TomTom Points database (formerly the Centrus

TeleAtlas Points database), delete these files: points.gsd and points.gsi.
b) Copy these files to the Spectrum™ Technology Platform server: points.gsd and points.gsi.

5. After you install the database files, use the Database Resource tool in the Management Console to
define the database as a resource. For more information, see "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform User's Guide.

Early Warning System (U.S. Only)
The USPS provides free Early Warning System (EWS) data to prevent matching errors due to the age
of the address information in the .gsd files. The USPS creates a new EWS data set each week that you
can download from the USPS website (www.ribbs.usps.gov).

To install the Early Warning System (EWS) database rename the database file from OUT to EWS.txt
and place it in the same folder as the primary database.

Installing Enterprise Routing Module Databases
1. To install the routing databases you need to meet the following requirements:

• You must have Java 6 installed.
• You must point your Java_Home environment variable to your JDK 1.6 installation location.

If you have Oracle environment variables set in your profile, these environment variables
may interfere with DVD database loading processes. If you experience database loading

Note:

problems and are using Oracle, please check that the Oracle environment variables are not
active when you perform the DVD database loads.

2. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:
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3. If you are installing from DVD and your system auto-mounts, skip this step. If you system does not
auto-mount, issue the appropriate mount command to indicate that the DVD device is a file system.

4. If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

6. Source the "setup" bourne shell script to setup the environment by typing the following command:
. ./setup

7. Execute the dbloader.bin script.
8. Follow the prompts as the script verifies your environment and database location.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

9. If the database requires keys and you did not enter the key for the database, see Adding Modules
and Features on page 87 for instructions on adding access keys.

10. After you install the database files, use the Database Resource tool in the Management Console to
define the database as a resource. For more information, see "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform User's Guide.

Installing Enterprise Tax Module Databases
Depending on the features you have licensed, you need to install one or more of these databases:

• Installing Master Files, Taxware, Vertex, and Boundary Files on page 32
• Installing Florida Format Files on page 33
• Installing TS-158 Format Files on page 34
• Installing the GeoTAX Auxiliary File on page 34
• Installing a User Auxiliary File on page 35
• Installing Payroll Tax Correspondence Files on page 35

Installing Master Files, Taxware, Vertex, and Boundary Files

1. Insert the database disc, or download the database from the Pitney Bowes Software website.
2. Open a command prompt.
3. If the database that you are installing is larger than 2 GB, type the following two commands:

export LARGE_FILE_LIMIT_2TB=1
export USE_LARGE_FILE_API=1
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4. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

5. Type the following to source the setup script:
. ./setup

6. Run the database install script installdb_gsl.
7. Select the database you want to install:

• GeoTAX Master Files—The master files are the main data files used by the Enterprise Tax
module. They identify all geographic components associated with a street address, such as the
latitude/longitude, census tract, and block group. The GeoTAXmaster files are on the disc labeled
"GeoTAX Subscription."

• Boundary File—Boundary files provide additional data about locations of special tax districts:
Special Purpose Tax Districts (SPD.txb), Insurance Premium Tax Districts (IPD.txb), Payroll Tax
Districts (PAY.txb), and Personal Property Tax Districts (PTD.txb).

• Taxware® cross reference file—Select this option to install the Taxware® sales tax cross-reference
file. Sales tax cross-reference files allow you to use the Enterprise Tax module to determine tax
jurisdictions for a given address, then use Taxware® software to determine the sales tax rates
for those jurisdictions.

• Vertex® cross reference file—Select this option to install the Vertex® cross-reference file if you
obtained the file from Vertex. Sales tax cross-reference files allow you to use the Enterprise Tax
module to determine tax jurisdictions for a given address, then use Vertex® software to determine
the sales tax rates for those jurisdictions.

• PBBI Vertex® cross reference file—Select this option to install the Vertex® cross-reference file
supplied by Pitney Bowes Software.

8. Specify the source folder. Some databases also require you to specify the source file.
9. Specify the destination. The program creates the specified database.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

10. In Management Console, open the Enterprise Tax Module database resource tool and define a
database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing Florida Format Files
You can obtain the Florida format files from the Florida Department of Revenue. The Florida Department
of Revenue compiles the database based on county.

1. Download the files from the Florida website at: geotax.state.fl.us/dorPubIdx.jsp
2. Unzip the downloaded files and transfer them to the server.

Be sure to FTP your files in binary format.Note:

3. Combine the county files into a single file if you downloaded more than one county. If you downloaded
the entire state list, you have approximately 67 files. You must combine all the files into one file.

4. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

5. Type the following to source the setup script:
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. ./setup

6. Run the database install script installdb_gsl.
7. Specify the source folder. Some databases also require you to specify the source file.
8. Specify the destination. The program creates the specified database.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

9. Ensure the DD_G1GTSST, DD_G1GTSSN, and DD_G1GTSSD file definition variables are defined.
10. In Management Console, open the Enterprise Tax Module database resource tool and define a

database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing TS-158 Format Files
The Federation of Tax Administrators (FTA) maintains a website with links to all data sources that use
the TS-158 format.

1. Download the files from: geotax.state.fl.us/dorPubIdx.jsp.
2. Unzip the downloaded files and transfer them to the Spectrum™ Technology Platform server.
3. State files are often broken up into individual county files. Combine all state and/or county files into

a single file.
4. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-

stalled.
5. Type the following to source the setup script:

. ./setup

6. Run the database install script installdb_gsl.
7. Select State supplied TS-158 format file.
8. Specify the source folder. Some databases also require you to specify the source file.
9. Specify the destination. The program creates the specified database.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

10. Ensure that the DD_G1GTGST, DD_G1GTGSN, and DD_G1GTGSD file definition variables are
defined.

11. In Management Console, open the Enterprise Tax Module database resource tool and define a
database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing the GeoTAX Auxiliary File
The GeoTAX Auxiliary file contains new addresses that have not yet been added to the Master File. It
provides the most up-to-date address data possible.

1. Insert the database disc, or download the database from the Pitney Bowes Software website.
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2. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

3. Type the following to source the setup script:
. ./setup

4. Run the database install script installdb_gsl.
5. Follow the prompts to select the file input and output areas, enter the directory of the GeoTAX auxil-

iary file, and enter the name of the GeoTAX auxiliary file.
The program creates the indexed sequential file g1gtax2 in the output area you specified. The Enter-
prise Tax Module can now use the auxiliary file for matching.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. In Management Console, open the Enterprise Tax Module database resource tool and define a
database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing a User Auxiliary File
A user-defined auxiliary file contains addresses that override the results from master files in street-level
matching. For instructions on creating a user-defined auxiliary file, see the Spectrum™ Technology
Platform User's Guide.

1. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

2. Type the following to source the setup script:
. ./setup

3. Run the database install script installdb_gsl.
4. Select User auxiliary file.
5. Follow the prompts to select the file input and output areas, enter the directory of the GeoTAX auxil-

iary file, and enter the name of the GeoTAX auxiliary file.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

6. The program creates the file G1GTAUX.
7. In Management Console, open the Enterprise Tax Module database resource tool and define a

database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing Payroll Tax Correspondence Files
Payroll tax correspondence files, also called payroll tax cross-reference files, allow you to use third-party
software to determine the payroll tax rates for the tax jurisdictions returned by Assign GeoTAX Info.

1. Insert the database disc, or download the correspondence file from the Pitney Bowes Software
website.
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2. Change the working directory to the server/bin directory of where Spectrum™ Technology Platform
is installed.

3. Run the database install script installdb_gsl.
4. Select Payroll tax correspondence file.
5. Specify the source folder. Some databases also require you to specify the source file.
6. Specify the destination. The program creates the specified database.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

7. The program produces a database files called G1GTPTC and G1GTPTC.vix.
8. In Management Console, open the Enterprise Tax Module database resource tool and define a

database resource that includes the database you just installed. Be sure to update Assign GeoTAX
info to use the new database resource.

Installing the Global Sentry Module Database
The following databases are required to run Global Sentry in real-time mode:

• globalsentrydb.script
• globalsentrydb.properties

The following databases are required to run Global Sentry in batch mode:

• globalsentrydb.script
• globalsentrydb.properties
• globalsentrydb.addresses.csv
• globalsentrydb.fullnames.csv
• globalsentrydb.ids.csv
• globalsentrydb.names.csv

In addition, you must install the Data Normalization Module databases to use Global Sentry. For instruc-
tions, see Installing Data Normalization Module Databases on page 26.

If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. If you have an existing Global Sentry database installed:
a) Change directories to <InstallLocation>/GlobalSentryDatabase/bin.
b) Type: ./globalsentrydb.stop

2. Make sure that Spectrum™ Technology Platform is stopped. To stop Spectrum™ Technology Platform,
change the working directory to the bin directory of where Spectrum™ Technology Platform is installed,
then type the following command:
./server.stop
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3. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

4. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system. If necessary, issue the /etc/filesystem
command to update your system so that it recognizes this file system. Specify the correct device
name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. In the server/bin directory, source the "setup" bourne shell script to setup the environment by
typing the following command:
. ./setup

6. Execute the script for installing the database by typing the following command:

./installdb_ois

7. Follow the prompts as the script verifies your environment and database location.

You may install databases on a network drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

8. If the database requires keys and you did not enter the key for the database, see Adding Modules
and Features on page 87 for instructions on adding access keys.

9. After installing the Global Sentry Module database, you must configure a JDBC connection in the
Spectrum™ Technology Platform Management Console.

10. Type ./globalsentrydb.start to start the server.
11. Start Spectrum™ Technology Platform. To start Spectrum™ Technology Platform, change the working

directory to the bin directory of where Spectrum™ Technology Platform is installed, then type the
following command:
./server.start

12. Open Management Console by clicking Start > Programs > Pitney Bowes > Spectrum™ Techno-
logy Platform > Client Tools > Management Console.

13. Under Resources, select JDBC Drivers.
14. Click Add.
15. Type the JDBC properties in the applicable text box:

• JDBC driver configuration name: HSQLDB
• JDBC driver class name: org.hsqldb.jdbcDriver
• Connection string template: jdbc:hsqldb:hsql://${host}:${port}/${instance}

16. Add the following driver file:
file:<SpectrumPlatformLocation>/GlobalSentryDatabase/lib/hsqldb.jar

17. Add the following Connection properties:
a) Click Add. In the JDBC Connection property dialog box, type "Password" in both the Label and

the Property Token fields and click OK.
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b) Click Add. In the JDBC Connection property dialog box type "User" in the label and the property
token fields and click OK.

18. Click OK.
19. Under Resources, click Connections.
20. Click Add.
21. Define the following connection properties:

• Connection name: Global Sentry
• Database driver: select the HSQLDB JDBC driver that you created in the previous steps.

22. Enter the following values in the Connection Properties dialog box:

• user: sa
• password: <there is no password>
• host: localhost or <your server name>
• port: 9001
• instance: globalsentrydb

23. Click Test to verify the connection works.
24. Click OK, then click OK again.

Installing Location Intelligence Module Databases
1. Place the data on the file system, or install the data into a database.

If your data is in the form of MapInfo TAB files, you can use the MapInfo EasyLoader utility
to upload the TAB files into a remote database such as Oracle, SQL Server, Microsoft Access

Note:

or PostgresSQL/ PostGIS. The spatial information in the TAB files is maintained in the remote
database. The EasyLoader utility is available for download at http://www.pbinsight.com/sup-
port/product-downloads/for/easyloader. For information about how to use EasyLoader,
see the EasyLoader User Guide that is included when you install EasyLoader.

2. Use the Named Connection and Named Table tools in the Location Intelligence Module section of
the Management Console to define the database resources.
For more information, see the "Configuring Database Resources" chapter of the Spectrum™ Techno-
logy Platform User's Guide.

Installing Universal Addressing Module Databases
This procedure describes how to install databases used by Get Candidate Addresses, Get City State
Province, Get Postal Codes, Validate Address, and Validate Address AUS. For instructions on installing
databases used by Validate Address Global, see Installing Validate Address Global Databases on
page 39.
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If you have Oracle environment variables set in your profile, these environment variables may
interfere with DVD database loading processes. If you experience database loading problems

Note:

and are using Oracle, please check that the Oracle environment variables are not active when
you perform the DVD database loads.

1. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

2. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system. If necessary, issue the /etc/filesystem
command to update your system so that it recognizes this file system. Specify the correct device
name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

3. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

4. Source the "setup" bourne shell script to setup the environment by typing the following command:
. ./setup

5. Execute the script for installing the database by typing the following command:

./installdb_unc

6. Follow the prompts as the script verifies your environment and database location.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

7. If you choose to install Residential Delivery Indicator, an optional database that you license directly
from the U.S. Postal Service, you are prompted for the nine-digit RDI table and the eleven-digit RDI
table. These are the .R9 and .R11 files provided from the U.S. Postal Service.

8. If the database requires keys and you have not entered the key, see Adding Modules and Features
on page 87 for instructions on adding access keys.

Installing Validate Address Global Databases
This procedure describes how to install the databases used by the Validate Address Global stage. For
instructions on installing databases used by other Universal Addressing Module stages, see "Configuring
Database Resources" chapter of the Spectrum™ Technology Platform User's Guide.

1. Insert the database DVD or download the database from the technical support web site,
www.g1.com/support.

If you download the database from the Pitney Bowes Software web site, it will be downloaded
as a zip file. Unzip the database before proceeding with the installation.

Note:

2. Unzip the database file to the location you want. The database zip files are:

• VAGlobal-EMEA.zip—Contains the data for Europe, Middle East, and Africa.
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• VAGlobal-APAC.zip—Contains the data for Asia-Pacific.
• VAGlobal-Americas.zip—Contains the data for the Americas.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

3. To install the unlock code:
a) Open the following file in a text editor:

<SpectrumLocation>/server/modules/addressglobal/conf/unlockcodes.txt

b) Enter your unlock codes, one per line.
c) Save and close the file.

Installing Validate Address Loqate Databases
This procedure describes how to install the databases used by the Validate Address Loqate stage. For
instructions on installing databases used by other Universal Addressing Module stages, see "Configuring
Database Resources" chapter of the Spectrum™ Technology Platform User's Guide.

1. Insert the database DVD or download the database from the technical support web site,
www.g1.com/support.

If you download the database from the Pitney Bowes Software web site, it will be downloaded
as a zip file.

Note:

2. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system. If necessary, issue the /etc/filesystem
command to update your system so that it recognizes this file system. Specify the correct device
name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

3. Unzip the database file(s) to the location you want. If you are installing data from multiple zip files or
discs, be sure to unzip them all to the same location. The database zip files are:

• LQ0—Contains general database setup files.

Regardless of which set of data you use, the files in LQ0- must be installed.Note:

• LQ1—Contains the data for Middle East, Africa, and Asia-Pacific.
• LQ2—Contains the data for North, Central, and South America.
• LQ3—Contains the data for Europe.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

4. Change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled.

5. Source the "setup" bourne shell script to setup the environment by typing the following command:
. ./setup

6. Execute the script for installing the database by typing the following command:

Spectrum™ Technology Platform 8.0.0 SP340

Installing Validate Address Loqate Databases

http://www.g1.com/support


./install.bin

7. Follow the prompts as the script verifies your environment and database location.
8. If the database requires keys and you have not entered the key, see Adding Modules and Features

on page 87 for instructions on adding access keys.

Installing Universal Name Module Databases
The Universal Name Module provides a load utility to install databases. The database files that you load
depend on the databases you have licensed.

1. If you have Oracle environment variables set in your profile, these environment variables may interfere
with DVD database loading processes. If you experience database loading problems and are using
Oracle, check that the Oracle environment variables are not active when you perform the DVD
database loads.

2. Make sure that Spectrum™ Technology Platform is stopped. To stop Spectrum™ Technology Platform,
change the working directory to the bin directory of where Spectrum™ Technology Platform is in-
stalled, then type the following command:
./server.stop

3. Insert the database DVD or download the database from www.g1.com/support.

If you download the database from the technical support web site, it will be downloaded as
a zip file. Unzip the database before proceeding with the installation.

Note:

4. If you are installing from DVD and your system does not auto-mount, issue the appropriate mount
command to indicate that the DVD device is a file system.

If necessary, issue the /etc/filesystem command to update your system so that it recognizes
this file system. Specify the correct device name for the DVD device on your system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system.

Note:

5. Change the working directory to the bin directory of where Spectrum™ Technology Platform is installed.
6. Source the "setup" bourne shell script to setup the environment by typing the following command:

. ./setup

7. Execute the script for installing the database by typing the following command:
./installdb_cdq

8. Follow the prompts as the script verifies your environment and database location.

You may install databases on a mapped drive, but performance will be affected since you
will be accessing them on a network rather than accessing them locally.

Note:

9. If the database requires keys and you have not entered the key, see Adding Modules and Features
on page 87 for instructions on adding access keys.

10. Open the file <SpectrumDirectory>/server/bin/wrapper/wrapper.conf in a text editor.
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11. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum heap
size (wrapper.java.maxmemory) to reflect the total amount of memory required for the Arabic
Plus Pack and Asian Plus Pack. For the amount of memory required by these databases, seeMemory
on page 14.

12. Save and close wrapper.conf.
13. Start the Spectrum™ Technology Platform by changing the working directory to the bin directory of

where Spectrum™ Technology Platform is installed, then type the following command:
./server.start
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Installing the Client Tools
Before installing, be sure to read the release notes. The release notes contains important compatibility
information as well as release-specific installation notes.

The Spectrum™ Technology Platform client applications are Microsoft Windows applications that you
use to administer your server and design and run jobs. You must install them on a computer running
Microsoft Windows. Even though the client applications are Windows applications, you can use them
with a server running on Unix or Linux.

• Management Console—Use the Management Console to set processing defaults, manage jobs,
specify security settings, and other administrative tasks.

• Enterprise Designer— Use Enterprise Designer to create and manage dataflows.
• Interactive Driver—Use Interactive Driver to test different processing settings. Interactive Driver allows
you to run a small number of records through a process to preview the result.

• Job Executor—The Job Executor is a command line tool that allows you to run a job from a command
line or script. The job must have been previously created and saved on Spectrum™ Technology Platform
using Enterprise Designer.

• Process Flow Executor—The Process Flow Executor is a command line tool that allows the execution
of a process flow from a command line or script. The process flow must have been previously created
and saved on Spectrum™ Technology Platform using Enterprise Designer.

To install the client tools:

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named "myspectrumplat-
form" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. If you do not have Microsoft .NET Framework installed, click Microsoft .NET Framework link and
follow the prompts to install the Microsoft .NET Framework.

3. Click the link to install the client tool you want:

• To install Enterprise Designer, Management Console, or Interactive Driver, click Client Installers.
• To install Job Executor, click Job Executor.
• To install Process Flow Executor, click Process Flow Executor.
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Introduction to Installing the Client API
The Client API is used to integrate Spectrum™ Technology Platform functionality into your applications.
If you will be creating your own program to call Spectrum™ Technology Platform, you need to install the
Spectrum™ Technology PlatformClient API on the systemwhere you will be developing your application.

Java Requirement
To run the Client API install and uninstall procedures, you must have the Spectrum™ Technology Plat-
form-supported version of Java installed on your machine. Add the /jre/bin location to $PATH.

If you are installing the Client API on the same machine as Spectrum™ Technology Platform, you can
use the version of Java included with Spectrum™ Technology Platform by sourcing the server/bin
setup script in your Spectrum™ Technology Platform install location.

Installing the Client API
1. Insert the Spectrum™ Technology Platform Client API DVD or locate the installation folder where

you downloaded the installation software.
2. Type the following:

./sdkinst.bin

3. The installer guides you through the installation process.
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Configuring SAP
To configure the SAP Module and your SAP system,

1. Import .SAR Files on page 49
2. Configure the SAP GUI on page 49
3. Configure SAP Web Dynpro on page 53
4. Configure SAP ICWC on page 54

Import Dataflow Files
When you install the SAP Module, several dataflow files are automatically installed. Other dataflow files
must be manually copied into Spectrum™ Technology Platform.

1. If you are adding the Address Now Module, Enterprise Tax Module, or Universal Addressing Module
to an existing installation,
a) Open Spectrum™ Technology Platform Enterprise Designer.
b) Select View > Server Explorer.
c) Delete this dataflow: SAPValidateAddressWithCandidates.

2. Go to: $G1DCG/server/modules/dataflows/sap.
3. Review the following table then copy the applicable dataflow files to:

$G1DCG/server/app/import

Table 1: Dataflow Files To Import

Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Universal Addressing Module and
Address Now Module and Enter-
prise Enterprise Tax Module SAPGenerateCASSReport.df

SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ANOW_ETM.df

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidates.ANOW.df
SAPValidateAddressWithCandidates.UAM.df

Universal Addressing Module and
Address Now Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Universal Addressing Module and
Enterprise Tax Module

SAPGenerateCASSReport.df
SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df
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Copy these dataflow files to the import folderIf you are installing this set of
modules

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidates.UAM.df

Universal AddressingModule only

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df

Enterprise Tax Module only

SAPValidateAddressWithCandidates.ANOW.dfAddress Now Module only

The following dataflows were automatically installed when you installed the SAP Module:Note:

• SAPGenerateMatchKey.df
• SAPGenerateMatchScore.df
• SAPGenerateSearchKey.df

If errors occur in Management Console or Enterprise Designer, delete the contents of
<WindowsTemporaryDirectory>\g1Assemblies, where <WindowsTemporaryDirectory>

Note:

is one of the following: %TMP%, %TEMP%, %USERPROFILE%, or the Windows directory.
Typically, C:\Documents and Settings\<USERNAME>\Local Settings\Temp\g1Assemblies.
After you delete the contents of this folder log in again.

Import .SAR Files
A .SAR file is a file that contains a third-party add-on package for SAP, such as the Spectrum™ Technology
Platform SAP Module. The .SAR file is located on the Spectrum™ Technology Platform DVD in the SAP
Objects folder. For information on importing .SAR files into SAP applications, see your SAP Basis ad-
ministrator.

Configure the SAP GUI
Before continuing make sure that you have done the following:

• Either the SAP ECC or SAP CRM environment is available
• The SAR file has been deployed

1. Activate the BC sets.
a) Log-on to the client where the settings for the Spectrum™ Technology Platform SAP Module is

to be configured.
b) Enter the T-Code SCPR20 to activate Business Configuration (BC) sets. This will place the default

entries on the Spectrum™ Technology Platform customizing tables. Enter the BCSet /HSGRP1/BC-
SET_BC_BAS_PV. Activate it with the options Overwrite Data and Default Mode.
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c) After activating the BC set for Postal Validation, select and activate the remaining BC Sets
(/HSGRP1/BCSET_BC_BAS_DES, /HSGRP1/BCSET_BC_BAS_GTX, /HSGRP1/MERGE_SET-
TINGS) with the Activation Options set to Overwrite Data and Expert Mode.

2. Set Up the RFC destination.
a) Go to transaction SM59. Click Create.
b) Complete the details of the RFC. Enter any valid name in RFC Destination, select G (HTTP

connection to external server) in Connection Type and add a short description in Description 1,
and then press Enter.

c) On the Technical Settings tab, in the Target Host field, enter the computer name or IP Address
of the server where the Spectrum™ Technology Platform server was installed. In the Service No
field enter 8080.
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d) On the Special Options tab, select No Timeout and HTTP 1.1 on HTTP Setting, and then save
the configuration.
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e) After you save, test the RFC by clicking the Connection Test button. If there is a popup window,
check the Accept All Further Cookies checkbox and select YES. When the test is successful, go
to Response Body tab to view the Spectrum™ Technology Platform page.

3. Setting up the Spectrum™ Technology Platform Logging Object
a) Go to Transaction code SLG0 and On the screen select New Entries then add /HSGRP1/DQC

as the Object and DQC Logging as the Object Text and save.
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Configure SAP Web Dynpro
Before continuing make sure that you have done the following:

• Make sure that you have configured the SAP Interface. For more information, see Configure the SAP
GUI on page 49.

• SAP Application, SAP NetWeaver 7.01 with Patch 3 and Spectrum™ Technology Platform is available
• PBS SCA files has been deployed.
• System Landscape Directory (SLD) has been properly configured

1. Set up JCO destinations:
a) Go to the NetWeaver Portal Content Administrator URL and login as J2EE_ADMIN or an account

that has an Administrator Privilege.
b) Expand Deployed Content, then pb.com, then pb.com/dqc. On the Details window, select the

JCO Connections tab.
c) Select WD_DQC_MODELDATA_DEST and click Create. Complete all the required information

to be able to run and test the connection.
d) Repeat the steps and complete the required information for WD_DQC_MODELDATA_DEST.

WD_DQC_MODELDATA_DEST is the Application Data and
WD_DQC_RFC_METADATA_DEST is the Dictionary Metadata.

Note:

2. Configure the BuildGlobalAddress web service in the SAP Visual Admin:
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a) Go to <drive>:/usr./sap/<system id>/DVEBMGS01/ j2ee/admin and click go.bat and enter
J2EE_ADMIN password.

b) Go to Cluster > Server > Services > JCo RFC Provider and select the Bundles tab.
c) Enter all of the information needed by the application and click Set to save the changes.
d) Go to Cluster > Server > Services > Web Services Security .
e) Create a proxy in Web Services Client > sap.com > Dynamic WSProxies with the name PB-

BIWebServiceConnectorBGA.
f) For the URL, enter:

http://<spectrumservername>:<port>/services/BuildGlobalAddress?wsdl

For example,

http://MySpectrumServer:8080/services/BuildGlobalAddress?wsdl

g) Restart the application server.

Configure SAP ICWC
Before continuing make sure that you have done the following:

• SAP CRM 6.0 and Spectrum™ Technology Platform is available
• Spectrum™ Technology Platform SAR files has been deployed
• ICWC user has the CRM_UI_PROFILE parameter ID with IC_AGENT as the Parameter Value
• Check duplicate option is activated in SPRO under ICWC (SPRO > CRM > ICWC > Define Account
Identification Profiles)

To configure the SAP ICWC:

1. Activate BC Sets.

See Configure the SAP GUI on page 49 for the initial steps. After performing the activation for all
available Group1 BC sets, activate the BC Set for Group1 ICWC (/HSGRP1/ICWC_SETTINGS)
Activation Options Overwrite Data and Expert Mode.

2. Set up the RFC Destination. For more information, see Configure the SAP GUI on page 49.
3. Set up the Group1 Logging Object. For more information, see Configure the SAP GUI on page 49.
4. Enable the Group1 ICWC Enhancement Set.

Enter T-CODE SM30. In the Table View text box, enter BSPWDV_EHSET_ASG and then click
Maintain to change the current configurations.

Select New Entries to add the Spectrum™ Technology Platform Enhancement Set. After the screen
is displayed, type the client number where the enhancement set would take effect and the enter
/HSGRP1/ENHANCEMENT_SET as the Enhancement Set.

5. Add the ICWC Configurations.

Enter T-CODE BSP_WD_CMPWB. Enter ICCMP_DETAIL in the Component text box and /HS-
GRP1/ENHANCEMENT_SET in the Enhancement Set text box and click Display.

Expand Views and select /HSGRP1/BUPA_CMP_VIEW/BuPaDetailSelectDuplCustomer.
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After the View is displayed, go to the Configuration tab and edit the configurations. On the edit screen
select Full Name, Telephone, Street, City and Country context and click the right arrow button and
arrange it in this order; Full Name, Telephone, Street, City, and Country. Save the configuration.

Configuring French Address Validation
If you will be using French address validation, you must install the Data Normalization Module table
cdq-TableLookup-SAP.tba. For more information, see Installing Data Normalization Module
Databases on page 26.

Configuring Siebel
To configure the Siebel module and your Siebel system,

1. Import Dataflow Files on page 55
2. (Optional) Verify the Geocoding Database Resource Name on page 57
3. Integrate Spectrum™ Technology Platform with Siebel on page 57

Import Dataflow Files
When you install the Siebel module, several dataflow files are automatically installed. Other dataflow
files must be manually copied into Spectrum™ Technology Platform.

1. If you are adding the Address Now Module, Enterprise Geocoding Module, or Universal Addressing
Module to an existing Siebel Module installation,
a) Open Spectrum™ Technology Platform Enterprise Designer.
b) Select View > Server Explorer.
c) Delete these dataflows:

• SiebelValidateAddressWithCandidates
• SiebelValidateAddressWithNoCandidates
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2. Do one of the following:

• If you are installing the Siebel Module for Siebel Business Application, go to: $G1DCG/serv-
er/modules/dataflows/siebel/sea

• If you are installing the Siebel Module for Siebel Industry Application, go to: $G1DCG/serv-
er/modules/dataflows/siebel/sia

3. Review the following table then copy the applicable dataflow files to:

$G1DCG/server/app/import

Table 2: Dataflow Files To Import

Copy these dataflow files to the import directoryIf you are installing this set of
modules

SiebelGeocodeUSAddressWithCandidates.df (subflow) Siebel-
GeocodeUSAddressWithNoCandidates.df (subflow) SiebelGet-

Universal Addressing Module and
Address Now Module and Enter-
prise Geocoding Module GlobalCandidateAddresses.df (subflow) SiebelValidateAddress-

WithCandidates.UAM_EGM_ADN.df SiebelValidateAddressWith-
NoCandidates.UAM_EGM_ADN.df

SiebelGetGlobalCandidateAddresses.df (subflow) SiebelValid-
ateAddressWithCandidates.UAM_ADN.df SiebelValidateAddress-
WithNoCandidates.UAM_ADN.df

Universal Addressing Module and
Address Now Module

SiebelGeocodeUSAddressWithCandidates.df (subflow) Siebel-
GeocodeUSAddressWithNoCandidates.df (subflow) SiebelVal-

Universal Addressing Module and
Enterprise Geocoding Module

idateAddressWithCandidates.UAM_EGM.df SiebelValidateAd-
dressWithNoCandidates.UAM_EGM.df

SiebelGeocodeUSAddressWithCandidates.df (subflow) Siebel-
GeocodeUSAddressWithNoCandidates.df (subflow) SiebelGet-

Enterprise GeocodingModule and
Address Now Module

GlobalCandidateAddresses.df (subflow) SiebelValidateAddress-
WithCandidates.EGM_ADN.dfSiebelValidateAddressWithNoCan-
didates.EGM_ADN.df

SiebelValidateAddressWithCandidates.UAM.df SiebelValidate-
AddressWithNoCandidates.UAM.df

Universal AddressingModule only

SiebelValidateAddressWithCandidates.EGM.df SiebelValidate-
AddressWithNoCandidates.EGM.df

EnterpriseGeocodingModule only

SiebelGetGlobalCandidateAddresses.df (subflow) SiebelValid-
ateAddressWithCandidates.ADN.df SiebelValidateAddressWith-
NoCandidates.ADN.df

Address Now Module only

The following dataflows were automatically installed when you installed the Siebel Module:Note:

• SiebelBusinessNameStandardization.df
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Copy these dataflow files to the import directoryIf you are installing this set of
modules

• SiebelStandardizeName.df
• SiebelGenerateMatchKey.df
• SiebelGenerateMatchScore.df
• SiebelGenerateSearchKey.df

If errors occur in Management Console or Enterprise Designer, delete the contents of
<WindowsTemporaryDirectory>\g1Assemblies, where <WindowsTemporaryDirectory>

Note:

is one of the following: %TMP%, %TEMP%, %USERPROFILE%, or the Windows directory.
Typically, C:\Documents and Settings\<USERNAME>\Local Settings\Temp\g1Assemblies.
After you delete the contents of this folder log in again.

(Optional) Verify the Geocoding Database Resource Name
If you are using the Enterprise Geocoding Module,

1. In Enterprise Designer, open each of these dataflows: SiebelGeocodeUSAddressWithCandidates
and SiebelGeocodeUSAddressWithNoCandidates.

2. In each dataflow, open the Geocode US Address stage.
3. In the Database field, select the name of the geocoding database as defined in the Management

Console. The default name is KGDDatasource but if the geocoding database has a different name
on your system, select the appropriate name.

For more information about database resources, see the "Spectrum™ Technology Platform
Administration" chapter of the Spectrum™ Technology Platform User's Guide.

Note:

4. Save and close each dataflow.

Integrate Spectrum™ Technology Platform with Siebel

1. Copy Siebel objects to your system:
a) Open the Spectrum™ Technology Platform DVD. If you downloaded Spectrum™ Technology

Platform, browse to the location where you downloaded the software.
b) Browse to the appropriate folder for your version of Siebel as shown in the following table.

FolderSiebel Version

Siebel Objects\7.8\EnterpriseSiebel Enterprise 7.8

Siebel Objects\7.8\IndustrySiebel Industry 7.8

Siebel Objects\8.0\Business\non SDQSiebel Business 8.0 Non-SDQ

Siebel Objects\8.0\Business\SDQSiebel Business 8.0 SDQ
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FolderSiebel Version

Siebel Objects\8.0\Industry\non SDQSiebel Industry 8.0 Non-SDQ

Siebel Objects\8.0\Industry\SDQSiebel Industry 8.0 SDQ

Siebel Objects\8.1.1\Business\non
SDQ

Siebel Business 8.1.1 Non-SDQ

Siebel Objects\8.1.1\Business\SDQSiebel Business 8.1.1 SDQ

Siebel Objects\8.1.1\Industry\non
SDQ

Siebel Industry 8.1.1 Non-SDQ

Siebel Objects\8.1.1\Industry\SDQSiebel Industry 8.1.1 SDQ

c) Copy the contents of the folder to a temporary directory. This temporary folder will be the referred
to as <Spectrum Package> in the following steps.

2. Create objects and allow object locking:
a) Log in to Siebel Tools as the user SADMIN, with the connection pointing to the server data source.
b) (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry

8.0/8.1.1 non-SDQ only.) Go to Object Explorer, drill down to the Project object. From the Project
area, right-click and select New Record. Create the following projects:

• Group 1 Data Quality
• Group 1 EAI Testing
• Group 1 Workflow

c) Open the file <Spectrum Package>\tools\CDQP_Queries.txt.
d) Copy and paste the query contents to the Project list of your Object Manager. Cross-check the

query result with the table below and perform the action suggested. To toggle object locing, go
to Object Explorer and browse to the Project object. From the Project area, right-click and select
the project, and select Toggle Object Locking.

ActionProjectEnter-
prise

In-
dustry

In-
dustry
SDQ

Busi-
ness

Busi-
ness
SDQ

Toggle Object LockingAccountXXXX

Toggle Object LockingAccount (SCW)XXX

Toggle Object LockingAccount (SSE)XXXXX

Toggle Object LockingContactXXXXX

Toggle Object LockingContact (SSE)XXX
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ActionProjectEnter-
prise

In-
dustry

In-
dustry
SDQ

Busi-
ness

Busi-
ness
SDQ

Toggle Object LockingCUT AccountX

Toggle Object LockingCUTSiebelCommunic-
ations

X

Toggle Object LockingCUT UsageX

Toggle Object LockingDNB DataXXX

Toggle Object LockingDeDuplicationXXX

Toggle Object LockingeAutomotiveX

Toggle Object LockingEmployeeXXXXX

Toggle Object LockingFINS ContractX

Toggle Object LockingFINS Contract InfoX

Toggle Object LockingFINSDeal CommercialX

Toggle Object LockingFINS Financial Ser-
vices

X

Toggle Object LockingFINS OppportunityX

Create and Toggle
Object Locking

Group 1 Data QualityXXX

Create and Toggle
Object Locking

Group 1 EAI TestingXXXXX

Create and Toggle
Object Locking

Group 1 WorkflowXXXX

Toggle Object LockingList Mgmt (Import)XX

Toggle Object LockingList Mgmt (UI)XXXXX

Toggle Object LockingMvgXX

Toggle Object LockingOpptyXXX
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ActionProjectEnter-
prise

In-
dustry

In-
dustry
SDQ

Busi-
ness

Busi-
ness
SDQ

Toggle Object LockingOppty (SSE)XXX

Toggle Object LockingPersonal ContactXXXX

Toggle Object LockingPicklistXXXXX

Toggle Object LockingServer Component
Requests

XXX

Toggle Object LockingSiebel Sales Enter-
prise

XX

Toggle Object LockingSiebel Universal AgentXX

Toggle Object LockingVERT CUT AddressXX

Toggle Object LockingVERT Cut CommonX

3. Check out the Siebel Projects:
a) Log in to Siebel Tools on Local Datasource.
b) Select Tools > Checkout.
c) Select the projects indicated in the following table and click Checkout.

ProjectEnterpriseIndustryIndustry
SDQ

BusinessBusiness
SDQ

AccountXXXX

Account (SCW)XXX

Account (SSE)XXXXX

ContactXXXXX

Contact (SSE)XXX

CUT AccountX

CUTSiebel Communic-
ations

X
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ProjectEnterpriseIndustryIndustry
SDQ

BusinessBusiness
SDQ

CUT UsageX

DNB DataXXX

DeDuplicationXXX

eAutomotiveX

EmployeeXXXXX

FINS ContractX

FINS Contract InfoX

FINS Deal CommercialX

FINS Financial ServicesX

FINS OppportunityX

Group 1 Data QualityXXX

Group 1 EAI TestingXXXXX

Group 1 WorkflowXXXX

List Mgmt (Import)XX

List Mgmt (UI)XXXXX

MvgXX

OpptyXXX

Oppty (SSE)XXX

Personal ContactXXXX

PicklistXXXXX

Server Component Re-
quests

XXX
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ProjectEnterpriseIndustryIndustry
SDQ

BusinessBusiness
SDQ

Siebel Sales EnterpriseXX

Siebel Universal AgentXX

VERT CUT AddressXX

VERT Cut CommonX

4. (Siebel 7.8 and 8.0/8.1.1 non-SDQ only) Import the Spectrum™ Technology Platform Siebel objects:
a) Select Tools > Import from Archive.
b) Import the Siebel SIF files located in <Spectrum Package>\sif. Select Overwrite the object

definition in the repository and click Next to proceed until the import process has been com-
pleted.

Siebel Enterprise 7.8 and Siebel Industry 7.8:

• G1_NEW.sif
• G1_APPLET.sif
• G1_BO.sif
• G1_BC.sif
• G1_BC_SCRIPTS.sif
• G1_EAI_TESTING.sif
• G1_APPLICATION.sif
• G1_PICKLIST.sif
• G1_VIEW.sif

Siebel Business 8.0/8.1.1 non-SDQ and Siebel Industry 8.0/8.1.1 non-SDQ:

• G1_NEW.sif
• G1_APPLET.sif
• G1_BO.sif
• G1_LINK.sif
• G1_BC.sif
• G1_BC_SCRIPTS.sif
• G1_EAI_TESTING.sif
• G1_APPLICATION.sif
• G1_PICKLIST.sif
• G1_VIEW.sif
• G1_WORKFLOW.sif
• (8.1.1 only) Rebranding.sif

5. (Siebel Enterprise 7.8 and Siebel Industry 7.8 only) Deploy the data quality workflows:
a) Go to Workflow Process objects using the Object Explorer.
b) Right-click on the Workflow Processes area and choose Import Workflow Process.
c) Specify Group 1 Workflow as project name for each workflow imported.
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d) Import the workflows in the order shown in the following list. The workflows are located in
<Spectrum Package>\workflow.

1. Baseline workflows:

a. GROUP 1 ADMIN - VIEW ACCESS WORKFLOW
b. GROUP 1 ADMIN - ADMIN ACCESS WORKFLOW
c. GROUP 1 ADMIN - OPTIONS MANAGER WORKFLOW
d. GROUP 1 DATA CLEANSING WORKFLOW
e. GROUP 1 DNB ASYNC WORKFLOW
f. GROUP 1 GENERATE HASH KEY WORKFLOW
g. GROUP 1 GEOCODING WORKFLOW
h. GROUP 1 NAME CASING WORKFLOW
i. GROUP 1 NAME CASING (ACCOUNT) WORKFLOW BATCH

2. Async workflows:

a. GROUP 1 ASYNC ACCOUNT WORKFLOW
b. GROUP 1 ASYNC ADDRESS WORKFLOW
c. GROUP 1 ASYNC ASSOC ADDRESS ACCOUNT WORKFLOW
d. GROUP 1 ASYNC ASSOC ADDRESS CONTACT WORKFLOW
e. GROUP 1 ASYNC CONTACT WORKFLOW
f. GROUP 1 ASYNC DELETE DEDUP RESULT (ADDRESS) WORKFLOW
g. GROUP 1 ASYNC DELETE DEDUP RESULT (PARENT) WORKFLOW
h. GROUP 1 ASYNC PERSONAL ADDRESS CONTACT WORKFLOW
i. GROUP 1 ASYNC WORKFLOW

3. BNS workflows:

a. GROUP 1 BUSINESS NAME STANDARDIZATION WORKFLOW

4. Data cleansing workflows:

a. GROUP 1 DATA CLEANSING (ACCOUNT) WORKFLOW BATCH
b. GROUP 1 DATA CLEANSING (CONTACT) WORKFLOW BATCH
c. GROUP 1 DATA CLEANSING (PROSPECT) WORKFLOW BATCH
d. GROUP 1 DATA CLEANSING with GEOCODING (ACCOUNT) WORKFLOW BATCH
e. GROUP 1 DATA CLEANSING with GEOCODING (CONTACT) WORKFLOW BATCH
f. GROUP 1 DATA CLEANSING with GEOCODING (PROSPECT) WORKFLOW BATCH

5. Geocoding workflows:

a. GROUP 1 GEOCODING (Business Address) BATCH WORKFLOW
b. GROUP 1 GEOCODING (Personal Address) BATCH WORKFLOW
c. GROUP 1 GEOCODING (Prospect) BATCH WORKFLOW

6. Name casing worflows:

a. GROUP 1 NAME CASING (CONTACT) WORKFLOW BATCH
b. GROUP 1 NAME CASING (PROSPECT) WORKFLOW BATCH

7. Deduplication workflows:

a. GROUP 1 DATA DEDUPLICATION (ACCOUNT) WORKFLOW BATCH
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b. GROUP 1DATADEDUPLICATION (CONTACT - Business Address)WORKFLOWBATCH
c. GROUP 1DATADEDUPLICATION (CONTACT - Personal Address)WORKFLOWBATCH
d. GROUP 1 DATA DEDUPLICATION (PROSPECT) WORKFLOW BATCH
e. GROUP 1 DATA DEDUPLICATION WORKFLOW

8. DNB workflows:

a. GROUP 1 DNB BATCH WORKFLOW
b. GROUP 1 DNB EAI WORKFLOW
c. GROUP 1 DNB LOAD BATCH WORKFLOW
d. GROUP 1 DNB VBC WORKFLOW
e. GROUP 1 DNB WORKFLOW

9. Generate hashkey workflows:

a. GROUP 1 GENERATE HASH KEY (ACCOUNT) WORKFLOW BATCH
b. GROUP 1 GENERATE HASH KEY (CONTACT) WORKFLOW BATCH
c. GROUP 1 GENERATE HASH KEY (PROSPECT) WORKFLOW BATCH

10. EAI test workflows:

a. GROUP 1 ADMIN - EAI TEST (ACCOUNT) WORKFLOW
b. GROUP 1 ADMIN - EAI TEST (CONTACT with ACCOUNT) WORKFLOW
c. GROUP 1 ADMIN - EAI TEST (CONTACT with ACCOUNT_PERSONAL ADDRESS)

WORKFLOW
d. GROUP 1 ADMIN - EAI TEST (CONTACT with PERSONAL ADDRESS) WORKFLOW
e. GROUP 1 ADMIN - EAI TEST (PROSPECT) WORKFLOW

e) Copy the files from <Spectrum Package>\workflow to C:\.

• Group1_Data_Options_Manager.xml
• Group1_Data_Responsibilities.xml
• Group1_Data_Views.xml
• Group1_EAI_Dataload_Account.xml
• Group1_EAI_Dataload_Contact_With_Account.xml
• Group1_EAI_Dataload_Contact_With_Account_Personal_Address.xml
• Group1_EAI_Dataload_Contact_With_Personal_Address.xml
• Group1_EAI_Dataload_Prospect.xml

f) Go through each imported workflow in the same order listed above and click Deploy.

6. Check in all locked projects:
a) Select Tools > Check In.
b) Select all the Projects to check in and click Check in.

7. Compile all Projects:
a) Select Tools > Compile Projects.
b) Click All Projects.
c) In the Siebel Repository File field, enter the path of your Siebel Web Client SRF file.
d) Click Compile.

8. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ) Update the application .CFG flie:
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a) Open the appropriate .cfg file in an editor:

For example, for Siebel Enterprise 7.8 and Siebel Business 8.0/8.1.1:

• Siebel Call Center—uagent.cfg
• Siebel Sales—siebel.cfg

For example, for Siebel Industry 7.8 and Siebel Industry 8.0/8.1.1:

• eAutomotive—auto.cfg
• Financial—fins.cfg
• eCommunication—ecomm.cfg

Siebel .cfg files are usually found in the following locations:

• Siebel thick client—Siebel\<version>\web client\bin\enu
• Siebel thin client—<Siebel Server>/bin/enu

b) Add the following lines under the [SWE] section:
ClientBusinessService0 = G1 Async Service
ClientBusinessService1 = G1 Business Name Standardization Service
ClientBusinessService2 = G1 Common Browser Scripts Service
ClientBusinessService3 = G1 Common Server Scripts Service
ClientBusinessService4 = G1 DNB VBC Service
ClientBusinessService5 = G1 Data Cleansing Service
ClientBusinessService6 = G1 DeDuplication Service
ClientBusinessService7 = G1 Generate HashKey Service
ClientBusinessService8 = G1 GeoCoding Service
ClientBusinessService9 = G1 Interactive Service
ClientBusinessService10 = G1 Merge Records Service
ClientBusinessService11 = G1 Name Casing Service
ClientBusinessService12 = G1WebService

9. Deploy the Siebel objects in the client:

Keep a backup of the old SRF in case old binaries need to be re-implemented.Note:

a) Copy the generated SRF to your web client objects folder.

Example: /disk2/sia78/webclient/OBJECTS/enu/

b) (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Open a command prompt and go to the BIN directory of the web client.

Example: /disk2/sia78/webclient/BIN

c) (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Generate browser scripts by issuing the command:

genbscript [location of .cfg] [public/enu folder]

For example:

genbscript /disk2/sia78/webclient/BIN/enu/siebel.cfg sia78/webclient/PUB-
LIC/enu

d) (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Copy g1_check.gif and g1_x.gif from the temporary folder to
public\enu\imagespublic/enu/images in the Siebel server.
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e) (Siebel Business 8.0/8.1.1 SDQ and Siebel Industry 8.0/8.1.1 SDQ only) Copy the contents of
<Spectrum Package>\dll to your BIN folder.

f) (Siebel Business 8.0/8.1.1 SDQ and Siebel Industry 8.0/8.1.1 SDQ only) Copy the contents of
<Spectrum Package>\cfg to your BIN/ENU folder.

10. Deploy the Siebel objects to the server:
a) Login to the Siebel Server environment using the command prompt.
b) Go to the directory of the Siebel server:

cd /siebel_root/siebsrvr

c) Run the Siebel server environment settings by typing this command:

. ./siebenv.sh

d) Go to the BIN directory:

cd /siebel_root/siebsrvr/bin

e) Stop the Siebel Server by typing the command:

./siebel_server stop

f) Copy the generated SRF file to your web client objects folder.

Example (Siebel Business): /disk2/sea78/siebsrvr/OBJECTS/enu/

g) (Siebel Industry 7.8, Siebel Enterprise 7,8, Siebel Industry 8.0/8.1.1 non-SDQ, and Siebel Business
8.0/8.1.1 non-SDQ only) Open a command prompt and go to the BIN drive of the web client.

Example: /disk2/sea78/siebsrvr/BIN

h) (Siebel Industry 7.8, Siebel Enterprise 7.8, Siebel Industry 8.0/8.1.1 non-SDQ, and Siebel Business
8.0/8.1.1 non-SDQ only) Generate browser scripts by issuing this command:

genbscript [location of Siebel.cfg] [webmaster folder]

Example:

genbscript /disk2/sea78/siebsrvr/BIN/enu/siebel.cfg /disk2/sea78/siebsr-
vr/WEBMASTER/

i) (Siebel Industry 7.8, Siebel Enterprise 7.8, Siebel Industry 8.0/8.1.1 non-SDQ, and Siebel Business
8.0/8.1.1 non-SDQ only) Copy g1_check.gif and g1_x.gif from the temporary directory to
WEBMASTER/images/enu in the Siebel server.

For Siebel Thin Client, copy g1_check.gif and g1_x.gif from the temporary directory
to SWEApp/PUBLIC/enu/images.

Note:

j) (Siebel Industry 7.8, Siebel Enterprise 7.8, Siebel Industry 8.0/8.1.1 non-SDQ, and Siebel Business
8.0/8.1.1 non-SDQ only) Copy the generated browser scripts from /WEBMASTER to <SWEApp
Location>/public/ENU.

k) (Siebel Industry 8.0/8.1.1 SDQ, Siebel Business 8.0/8.1.1 SDQ only) Copy the contents of
<Spectrum Package>/lib/sol to your LIB folder.

l) (Siebel Industry 8.0/8.1.1 SDQ, Siebel Business 8.0/8.1.1 SDQ only) Copy the contents of
<Spectrum Package>/cfg to your BIN/ENU folder.

m) Go to the directory of the Siebel server:

cd /siebel_root/siebsrvr

n) Set the environment variable:

. ./siebenv.sh
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o) Go to the BIN directory:

cd /siebel_root/siebsrvr/bin

p) Start the Siebel server by typing this command:

./siebel_server start

11. Activate the Spectrum™ Technology Platform workflows in the Siebel web client:
a) Log in to the Siebel Application, connecting to the server data source.
b) Select Site Map > Administration - Business Process > Workflow Deployment.
c) Query for all the GROUP 1* workflows.
d) Click Activate for each workflow.
e) Query for all the Promote* workflows.
f) Click Activate for the ff workflows Promote Prospect (Single) and Promote Prospect (Many).

12. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Load the Group 1 configuration.
a) Log in to the Siebel application connecting to the server data source.
b) Go to Site Map > Administration - Business Service > Simulator.
c) In the top applet, create a new record and set the following fields:

Workflow Process ManagerService Name

Run ProcessMethod Name

1Iterations

d) In the Input Arguments applet, load:

<Spectrum Package>\tools\OptionsManagerLoadData.xml

Delete the entry if previous GROUP 1 options already exist in the database. Run the fol-
lowing SQL Script: DELETE SIEBEL.S_LST_OF_VAL WHERE CODE = 'G1'

Note:

e) Click Run in the top applet of the Simulator view. Delete the record.
f) Repeat steps c. and d. for the ff files:

• ViewAccessLoadData.xml
• AdminAccessLoadData.xml

g) Go to Site Map > Administration - Application > Responsibilities:
h) Query for the responsibility Group 1 Responsibility.
i) In the Users tab, add SADMIN or any Siebel administrator. This associates the Group 1 Adminis-

tration Screen to the user.

In order to see the changes you must log-in again.Note:

j) Go to Site Map > Administration - Group 1 Data Quality > Options Manager > General Be-
havior.

k) Change the server and port number where the Spectrum™ Technology Platform server is located.

13. Verify the installation:
a) Log in to Siebel Application.
b) All applets should load properly without error.
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14. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Modify and apply web services.
a) Go to Site Map > Administration - Web Services > Outbound Web Services.
b) Click Import on the Outbound Web Services area and then specify the file <Spectrum

Package>\tools\G1WebService.xml.
c) Query on the Name field ValidateAddress, and modify its settings as follows:

On the Service Port applet, change the following fields:

• Transport: Local Business Service
• Address: G1 WebService Filter Service

On the Operations applet, change the following fields:

• Response Filter Service Display: G1 WebService Filter Service
• Response Filter Method Display: filter Response

15. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Industry 8.0/8.1.1 non-SDQ, and Siebel Business
8.0/8.1.1 non-SDQ only) Encrypt and apply Spectrum™ Technology Platform user name and password.
a) Run the following command on the command prompt:

java -version

Java Runtime Environment (JRE) 1.4.x is required. If none is installed, you can download from
java.sun.com/j2se/1.4.2/download.html. Download the JRE of your target platform.

b) Acquire the file <Spectrum Package>\tools\Base64.class.
c) On the command prompt, type the following command:

java Base64 -encode -s "<username>:<password>"

where <username> and <password> is to the login information of Spectrum™ Technology Platform
server. Copy the generated value.

The default Spectrum™ Technology Platform password can be found in <Spectrum
Package>\tools\Default Password.txt.

Note:

d) Go to Site Map > Administration - Group 1 Data Quality > Password Manager. Paste the
value generated in step c. and click Save Changes.

16. (Siebel Business 8.0/8.1.1 SDQ and Siebel Industry 8.0/8.1.1 SDQ only) Configure the Siebel instance
configuration parameters:
a) Select Site Map > Administration - Server Configuration > Enterprises.
b) Verify/Change the ff Parameters:

• Data Cleansing Type—G1Cleansing
• DeDuplication Data Type—G1DataMatching

c) Select Component Definitions and select the ff components. For each component, verify para-
meters and values.
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Table 3: Siebel Business

Value/Value on RestartParameterComponent Definitions

G1CleansingData Cleansing Type*Data Quality Manager *Sales
Object Manager (ENU) *List Im-
port Service Manager TrueData Cleansing Enable Flag

G1DataMatchingDeDuplication Data Type

TrueDeDuplication Enable Flag

Table 4: Siebel Industry

Value/Value on RestartParameterComponent Definitions

G1CleansingData Cleansing Type*DataQuality Manager *eAuto-
motive Object Manager (ENU)
*List Import Service Manager TrueData Cleansing Enable Flag

G1DataMatchingDeDuplication Data Type

TrueDeDuplication Enable Flag

d) Select Site Map > Server Configuration > Servers. Repeat steps b through c for server config-
uration parameters.

e) Select Site Map > User Profile Preferences > Data Quality. Change the following settings:

ValueParameter

YesEnable DeDuplication

YesEnable Data Cleansing

f) Browse to <Siebel Installation>\bin\ENU and open the appropriate file:

• Siebel Business: siebel.cfg and uagent.cfg
• Siebel Industry: auto.cfg

g) Under the area [DataCleansing] change the ff Parameters:
Enable = TRUE
Type = G1Cleansing

h) Under the area [DeDuplication] change the ff Parameters:
Enable = TRUE
Type = G1DataMatching
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i) Select Site Map > Administration - Server Configuration. Click the Synchronize link and select
Synchronize after being redirected.

17. (Siebel Business 8.0/8.1.1 SDQ, Siebel Industry 8.0/8.1.1 SDQ only) Configure data cleansing con-
figuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the Vendor

Applet, include the ff value

DLL NameName

Group1ConnectorG1Cleansing

b) Add the ff BC Vendor Field Mapping:

Table 5: Siebel Business

OperationBusiness Component

Data CleansingAccount

Data CleansingBusiness Address

Data CleansingContact

Data CleansingList Mgmt Prospective Contact

Table 6: Siebel Industry

OperationBusiness Component

Data CleansingAccount

Data CleansingCUT Address

Data CleansingContact

Data CleansingList Mgmt Prospective Contact

c) Under each BC operation, add the ff field mappings:

Table 7: Siebel Business

Mapped FieldBusiness Component Field

Account
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Mapped FieldBusiness Component Field

FirmNameName

Business Address

CityCity

CountryNameCountry

USCountyNameCounty

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

DisableDataCleansingDisable DataCleansing

Contact

FirstNameFirst Name

LastNameLast Name

MiddleNameMiddle Name

TitleOfRespectM/M

List Management Prospective Contact

CityCity

CountryNameCountry
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Mapped FieldBusiness Component Field

USCountyNameCounty

FirstNameFirst Name

LastNameLast Name

MiddleNameMiddle Name

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

DisableDataCleansingDisable DataCleansing

Table 8: Siebel Industry

Mapped FieldBusiness Component Field

Account

FirmNameName

CUT Address

CityCity

CountryNameCountry

USCountyNameCounty
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Mapped FieldBusiness Component Field

LatitudeG1 Latitude

LocationCodeG1 Location Code

LongitudeG1 Longitude

MatchCodeG1 Match Code

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

DisableDataCleansingDisable Data Cleansing

Contact

FirstNameFirst Name

LastNameLast Name

MiddleNameMiddle Name

TitleOfRespectM/M

d) Add the ff Vendor Parameters.

Table 9: Siebel Business

ValueName

AccountAccount DataCleanse Record Type

Business AddressBusiness Address DataCleanse Record Type

ContactContact DataCleanse Record Type

List Mgmt Prospective ContactList Mgmt Prospective Contact DataCleanse Record
Type
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Table 10: Siebel Industry:

ValueName

AccountAccount DataCleanse Record Type

CUT AddressCUT Address DataCleanse Record Type

ContactContact DataCleanse Record Type

List Mgmt Prospective ContactList Mgmt Prospective Contact DataCleanse Record Type

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data Quality
Settings. Add the ff data for Data Quality Settings. These settings enable data cleansing for your
Siebel Application

ValueName

YesEnable DataCleansing

18. (Siebel Business 8.0/8.1.1 SDQ and Siebel Industry 8.0/8.1.1 SDQ only) Configure data matching
configuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the Vendor

Applet, include the ff value

DLL NameName

Group1ConnectorG1DataMatching

b) Add the ff BC Vendor Field Mapping:

Table 11: Siebel Business

OperationBusiness Component

DeDuplicationAccount

DeDuplicationBusiness Address

DeDuplicationContact

DeDuplicationList Mgmt Prospective Contact
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Table 12: Siebel Industry

OperationBusiness Component

DeDuplicationAccount

DeDuplicationCUT Address

DeDuplicationContact

DeDuplicationList Mgmt Prospective Contact

c) Under each BC Operation, add the ff Field Mappings.

Table 13: Siebel Business

Mapped FieldBusiness Component Field

Account

DedupTokenDedup Token

IdId

LocationLocation

NameName

CityPrimary Account City

CountryNamePrimary Account Country

PostalCodePrimary Account Postal Code

StateProvincePrimary Account State

AddressLine1Primary Account Street Address

Business Address

CityCity

CountryNameCountry

IdId
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Mapped FieldBusiness Component Field

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

AccountNamePrimary Account Name

CityPrimary City

CountryNamePrimary Country

PostalCodePrimary Postal Code

StateProvincePrimary State

List Management Prospective Contact

AccountAccount

CityCity

CountryNameCountry

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name
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Mapped FieldBusiness Component Field

PostalCodePostal Code

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

Table 14: Siebel Industry

Mapped FieldBusiness Component Field

Account

DedupTokenDedup Token

IdId

LocationLocation

NameName

CityPrimary Account City

CountryPrimary Account Country

PostalCodePrimary Account Postal Code

StatePrimary Account State

AddressLine1Primary Account Street Address

CUT Address

CityCity

CountryCountry

IdId

PostalCodePostal Code
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Mapped FieldBusiness Component Field

StateState

AddressLine1Street Address

AddressLine2Street Address 2

Contact

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

NamePrimary Account Name

CityPrimary City

CountryPrimary Country

CodePrimary Postal Code

StatePrimary State

List Management Prospective Contact

AccountAccount

CityCity

CountryNameCountry

FirstNameFirst Name

IdId

LastNameLast Name

MiddleNameMiddle Name

PostalCodePostal Code

Spectrum™ Technology Platform 8.0.0 SP378

Integrate Spectrum™ Technology Platform with Siebel



Mapped FieldBusiness Component Field

StateProvinceState

AddressLine1Street Address

AddressLine2Street Address 2

d) Add the ff Vendor Parameters:

Token Expression and Query Expression are custom fields in their respective Business
Components.

Note:

Table 15: Vendor Parameters

ValueName

AccountAccount DeDup Record Type

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

Account Query Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

Account Token Expression

200Batch Max Num of Records

Business Address(Siebel Business Only)

Business Address DeDup Record Type

CUT Address(Siebel Industry Only)

CUT Address DeDup Record Type

ContactContact DeDup Record Type

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

Contact Query Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

Contact Token Expression

List Mgmt Prospective ContactList Mgmt Prospective Contact DeDup
Record Type
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ValueName

"|" + [Query Expression 1] + [Query Expression 2] +
[Query Expression 3]

List Mgmt Prospective Contact Query
Expression

"|" + [Token Expression 1] + [Token Expression 2] +
[Token Expression 3]

List Mgmt Prospective Contact Token
Expression

200Realtime Max Num of Records

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data Quality
Settings. Add the ff data for Data Quality Settings. These settings enable data matching for your
Siebel Application.

ValueName

YesEnable DeDuplication

YesForce User DeDupe - Account

YesForce User DeDupe - Contact

YesForce User DeDupe - List Mgmt

19. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Configure Siebel server configuration events.

The Siebel server must be configured so that the records created in the local database can be syn-
chronized to the server.
a) Navigate to View > Administration - Server Configuration > Servers > Components > Event.
b) Locate the Workflow Process Manager Server components.
c) Set the following Component Event Configuration for Workflow Process Manager:

4Task Configuration

3Component Tracing

4SQL Parse and Execute

4Workflow Definition Loading

4Workflow Engine Invoked

4Workflow Step Execution

4Workflow Process Execution
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4Object Manager Business Service Operation
and SetErrorMsg Log

4Object Manager Business Component Opera-
tion and SetErrorMsg Log

4Object Manager SQL Log

d) Locate the Transaction Merger server components.
e) Set the following Component Event Configuration for Transaction Merger:

4General Events

3Components Tracing

4SQL Parse and Execute

20. (Siebel Enterprise 7.8, Siebel Industry 7.8, Siebel Business 8.0/8.1.1 non-SDQ, and Siebel Industry
8.0/8.1.1 non-SDQ only) Enable marketing server components.

The Marketing Server Components must be enabled to import a list from the List Management
business object.
a) Navigate to Administration - Server Configuration > Enterprises > Component Groups.
b) In the Spectrum™ Technology Platform Server list, select the appropriate server.
c) In the Enterprise Component Groups list, locate each of the required component groups using

the following table. If the Enable State field does not contain the value Enabled, select the
component groups, click the menu button, and choose Enable Component Group.

DescriptionComponentsGroup Name

Marketing Object Manager.
Supports the user interface and

MktgOM • Marketing Obj Mgr
• eMarketing Obj Mgr

business objects for theMarket-
ing application.

• eEvents Obj Mjr

Marketing Server. Used for list
management list import.

List Import Service ManagerMktg Srv

d) Click the Synchronize view tab and click Synchronize.
e) Restart the Siebel server. The Siebel server must be restarted each time synchronization occurs.
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8Starting the Server

In this section:

• Start Spectrum™ Technology Platform Server . . . . . . . .84



Start Spectrum™ Technology Platform Server
Start Spectrum™ Technology Platform when you are done installing any necessary databases.

Java uses /var/tmp as its temporary directory by default. If there is not enough space in this
directory, the Spectrum™ Technology Platform server may not start, and you may also experience
problems starting Management Console.

Note:

1. Change the working directory to the bin directory of where Spectrum™ Technology Platform is installed.
For example,
cd /usr/g1/tst/server/bin

2. Source the setup file. For example,
. ./setup

3. Launch Spectrum™ Technology Platform.

• To launch Spectrum™ Technology Platform in the background, type the following command:

./server.start

• To launch Spectrum™ Technology Platform in the foreground, type the following command:

./server.start console

To stop Spectrum™ Technology Platform, type the following command: ./server.stopNote:
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9Installing the Permanent
License File

In this section:

• Install Permanent License File . . . . . . . . . . . . . . . . . . . . .86



Install Permanent License File
A license file provides long-term access to your software pursuant to the terms of your license. For new
installations, the access key you enter during installation provides temporary access to the software for
45 days, allowing you to start using your software immediately while you obtain your license file. For
upgrades of existing Spectrum™ Technology Platform installation, you may continue to use your existing
license file; you do not need to get a new one.

Spectrum™ Technology Platform uses a licensemanagement system that enables Pitney Bowes Software
to administer agreements with customers and data providers. The licensemanagement systemmonitors
transaction counts, term limits, and regulatory compliance. Failure to adhere to license restrictions may
result in the disabling of the product until compliance is achieved.

You may be required to update your permanent license file(s) periodically. Pitney Bowes Software may
request system audits and reports to provide you with updated license files.

1. Go to www.g1.com/support.
2. Log in to support.
3. Click My Products, select the correct product name, and click View Detail.
4. In the License File column, click Get. A page appears with a link to download your license file.

For some modules you will need to view available downloads for the sub component before
you see the Get link.

Note:

5. Click Download License File.
6. After you download the license file, copy it to the following directory:

$G1DCG/server/app/import

7. The license file(s) will be applied to your system. If there was a problem installing the license file,
check the log file in:

$G1DCG/server/app/repository/logs

Depending on whether the key was processed successfully or there was an error processing the
key, processed keys go into one of these folders:

• $G1DCG/server/app/import/archive/license-Keys
• $G1DCG/server/app/import/error/license-Keys

License file information is company-specific. Protect it as you would your password.Note:

Spectrum™ Technology Platform 8.0.0 SP386

Install Permanent License File

http://www.g1.com/support


10Adding Modules and
Features

In this section:

• Adding Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .88
• Activating Features After Installation . . . . . . . . . . . . . . . .89



Adding Modules
Spectrum™ Technology Platform is designed so that modules can be added as you grow your system
over time. For example, you may have one Spectrum™ Technology Platform module and then license
another module a few months later. The second product may be built on a newer version of Spectrum™

Technology Platform. This will require you to upgrade your version of Spectrum™ Technology Platform.
In another case, the second product is compatible with the installed version. In both cases, the install
program recognizes if it needs to upgrade Spectrum™ Technology Platform and will do so without
prompting. If an upgrade is not required, the installer will skip the Spectrum™ Technology Platform install
steps and install the new module.

The process for adding a module is similar to that of a new installation. In both cases you start the install-
ation process by running the Spectrum™ Technology Platform installer. Note that Spectrum™ Technology
Platform modules do not have their own installer. Instead, you use the Spectrum™ Technology Platform
installer to add modules.

1. If the Spectrum™ Technology Platform server is running, stop the server by typing the following
command in the Spectrum™ Technology Platform bin directory:
./server.stop

2. Do one of the following:

• Download the new module from www.g1.com/support.
• If you are installing the new module from DVD, insert the Spectrum™ Technology Platform DVD.

If your system does not auto-mount, issue the appropriate mount command to indicate that the
DVD device is a file system.

Your system must allow DVDs created under the ISO 9660 format to be mounted as a file
system. You may experience file loading difficulties when using DVDs mounted with the

Note:

Rockridge extension. Pitney Bowes Software recommends using the standard ISO 9660
format without extensions.

3. Change the directory to the location of install.sh, either on the Spectrum™ Technology Platform
DVD or in the location where you downloaded the Spectrum™ Technology Platform installation files
from the Pitney Bowes Software web site.

4. Source the install.sh script. This is required so you can change DVDs during installation. For
example:

. ./install.sh

The Spectrum™ Technology Platform Installer prompt displays.

5. When prompted, enter one or more valid access keys for the module you wish to add.
6. Load any necessary databases for the new product. See the instructions in Installing Databases

on page 23.
7. After you install the necessary databases (if any) start Spectrum™ Technology Platform. See the in-

structions in Start Spectrum™ Technology Platform Server on page 84.
8. Change directory to .../server/bin.
9. You must now enter the necessary access keys to use the module. For instructions, see Activating

Features After Installation on page 89.
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Activating Features After Installation
Spectrum™ Technology Platform and some modules have optional features. The access keys you
entered during the installation process activates the specific features that you have licensed. If you license
additional features after installing you can easily enter your new key to unlock the new features. For
example, if you originally install the Universal Addressing Module with just U.S. address support and
later want to add support for Canadian addresses, you can purchase an updated license, then update
your access keys without having to re-install the Universal Addressing Module.

To activate features and databases after the initial installation, follow these steps.

This procedure will activate features on software that you have already installed. It is not for
adding new modules. If you are adding a new module, see Adding Modules on page 88.

Note:

1. Change to the server/bin directory.
2. Source the setup script:

../setup

3. Type the following:

./accessKey.sh

Alternatively, you can point the access key installer to a file containing the keys you want to install.
To do this specify the -file parameter following by the file name. For example:

./accessKey.sh -file mykeys.txt
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11Removing Spectrum

In this section:

• Removing the Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
• Removing the Client Tools . . . . . . . . . . . . . . . . . . . . . . . . .92
• Removing the Client API . . . . . . . . . . . . . . . . . . . . . . . . . .92



Removing the Server
Before uninstalling any product, back up any files you may need in the future. Uninstalling Spectrum™

Technology Platform will remove any job definitions and server-default changes you may have made.

1. If the Spectrum™ Technology Platform server is running, stop the server by typing the following
command in the Spectrum™ Technology Platform working directory:
./server.stop

2. Source the setup file. For example,
. ./setup

3. Uninstall the Spectrum™ Technology Platform modules by running the uninstall script for each
module. The scripts are located in the Uninstall/Uninstall_<code> directory. For a list of
codes, see Installation Unit (IU) Codes on page 94.

4. After uninstalling all Spectrum™ Technology Platform modules, uninstall Spectrum™ Technology
Platform by running the uninstall script located in the Uninstall/Uninstall_LES directory.

Removing the Client Tools
1. Back up any files you may need in the future.
2. Use the Windows Add/Remove Programs control panel to uninstall the Spectrum™ Technology

Platform client tools or Client API.

Removing the Client API
1. Navigate to the folder where you installed the Client API. If you installed the Client API to the default

location, navigate to the following path: /PBSpectrum_ClientSDK/Uninstall_SDK.
2. Enter the following command and press Enter:

# ./Uninstall_SDK

3. The uninstall script walks you through the uninstall process.

If the Client API and the Spectrum™ Technology Platform server were installed on the same
machine and you used the Java installation from Spectrum™ Technology Platform to install

Note:

the Client API, you cannot remove the server before uninstalling the Client API. If you remove
the Spectrum™ Technology Platform server before removing the Client API, you will need to
install Java on your machine to complete the uninstallation of the Client API.
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AInstallation Unit Codes

In this section:

• Installation Unit (IU) Codes . . . . . . . . . . . . . . . . . . . . . . . .94



Installation Unit (IU) Codes
Table 16: IU Codes For Spectrum™ Technology Platform Modules

IU CodeModule Name

ADNAddress Now

CDQAdvanced Matching

BSMBusiness Steward Module

GRFData Hub Module

CDQData Normalization

IAUEnterprise Geocoding (Australia)

GLOBALEnterprise Geocoding (Global)

IGBEnterprise Geocoding (U.K.)

KGLEnterprise Geocoding (U.S.)

IXWEnterprise Geocoding (World)

GSLEnterprise Tax

GCOGeoConfidence

OISGlobal Sentry

LIMLocation Intelligence

CS6SAP CRM 6.0

70SSAP CRM 7.0

EC5SAP ECC 5.0

E6CSAP ECC 6.0
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IU CodeModule Name

SICSiebel Industry 7.8

SECSiebel Enterprise 7.8

SQBSiebel Business 8.0

81BSiebel Business 8.1.1

SQISiebel Industry 8.0

81ISiebel Industry 8.1.1

UNCUniversal Addressing

CDQUniversal Name
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